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Change History

This table lists the changes that are made to this guide. Most recent changes appear at the top.

Change See Date

Added Edge Chromium details Browser Settings for Agent and | December 2020
Supervisor Desktop

Added Edge Chromium details Client Requirements

Initial Release of Document for Release 12.5(1)

Updated supported versions of Platform Requirements January 2020
VMware
Added client OS details and Client Requirements

updated supported browsers

Added security enhancement details | Security Considerations

Updated HTTPS support details | Security Considerations

All the references to http://FQDN
of Finesse Server/ are changed to
https://FQDN of Finesse Server/

Updated failover considerations | Failover Considerations
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Change

See

Date

Updated filenames for OVA and
ReadMe

Installation Files

Updated upgrade path version
number

Supported Upgrade Paths and
Aligned Partitions Support

Updated upgrade details and added
a note on certificate validation

Perform Upgrade

Updated supported browsers and
added a note on the
recommendation for faster failover

Browser Settings for Agent and
Supervisor Desktop

Added Cloud Connect certificate
details

Cloud Connect Certificates

Added Customer Collaboration
Platform certificate details

Customer Collaboration Platform
Certificates

Added Cisco Web Proxy Service

Network and System Services Used
for Cisco Finesse

SocialMiner product name change

All references to SocialMiner are
changed to the Customer
Collaboration Platform.

About This Guide

The Cisco Finesse Installation and Upgrade Guide describes how to install Finesse, upgrade Finesse, and

Audience

perform initial configuration.

This guide is prepared for system engineers and administrators who are responsible for the installation and
initial configuration of Cisco Finesse.

Related Documents

Document or resource

Link

Cisco Finesse Documentation Guide

https://www.cisco.com/en/US/partner/products/ps11324/products_
documentation_roadmaps_list.html

Configure SNMP Trap in Cisco
Finesse

https://www.cisco.com/c/en/us/support/docs/contact-center/finesse/
214387-configure-snmp-trap-in-cisco-finesse.html
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Document or resource

Link

Cisco.com site for Finesse
documentation

https://www.cisco.com/en/US/partner/products/ps11324/tsd_products
support_series _home.html

Communications, Services, and Additional Information

* To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

* To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

* To submit a service request, visit Cisco Support.

» To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit

Cisco Marketplace.

* To obtain general networking, training, and certification titles, visit Cisco Press.

* To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.

Field Notice

Cisco publishes Field Notices to notify customers and partners about significant issues in Cisco products that
typically require an upgrade, workaround, or other user action. For more information, see Product Field Notice
Summary at https://www.cisco.com/c/en/us/support/web/tsd-products-field-notice-summary.html.

You can create custom subscriptions for Cisco products, series, or software to receive email alerts or consume
RSS feeds when new announcements are released for the following notices:

* Cisco Security Advisories

* Field Notices

* End-of-Sale or Support Announcements

* Software Updates

* Updates to Known Bugs

For more information on creating custom subscriptions, see My Notifications at https://cway.cisco.com/

mynotifications.
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Documentation Feedback

To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.

Conventions

This document uses the following conventions:

Convention

Description

boldface font

Boldface font is used to indicate commands, such as user entries, keys, buttons,
folder names, and submenu names.

For example:

» Choose Edit > Find.
« Click Finish.

italic font

Italic font is used to indicate the following:

* To introduce a new term. Example: A skill group is a collection of agents
who share similar skills.

* A syntax value that the user must replace. Example: IF (condition, true-value,
false-value)

* A book title. Example: See the Cisco Unified Contact Center Enterprise
Installation and Upgrade GuideCisco Unified Contact Center Enterprise
Installation and Upgrade Guide.

window font

Window font, such as Courier, is used for the following:

* Text as it appears in code or that the window displays. Example:
<html><title>Cisco Systems, Inc. </title></html>

Angle brackets are used to indicate the following:

* For arguments where the context does not allow italic, such as ASCII output.

* A character string that the user enters but that does not appear on the window
such as a password.
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CHAPTER 1

Installation Preparation

* System Requirements, on page 1
* Preinstallation Tasks, on page 6

System Requirements

This section provides a summary of the requirements for Cisco Finesse.

Platform Requirements

All Cisco Finesse servers run on virtual machines (VM) using the Unified Communications Operating System
(Unified OS). The supported versions must be installed before you install Cisco Finesse.

* Supported Versions of VMware vSphere ESXi—6.5 inclusive of all updates, 6.7 inclusive of all updates
(C240 M5 servers require minimum ESXI 6.5 U2).

* Supported VMware VMFS (Virtual Machine File System)—ESXi 6.5 with VMFS 5, ESXi 6.5 U2 and
later updates with VMFS 6, ESXi 6.7 with VMFS 6.

For more information about supported VMs and VMware requirements, Virtualization for Cisco Finesse.

Client Requirements

No Cisco Finesse software is installed on the clients. Agents and Supervisors use a web browser to access the
Finesse desktop. Administrators use a web browser to access the Finesse administration console. The following
table lists the supported operating systems and browsers for Cisco Finesse clients.
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Note When anew VM is deployed using Cisco provided OVA using thin-client vCenter 6.5, the Check and upgrade
Tools during power cycling setting is not enabled.

Manually enable this setting to ensure that the performance levels are not affected.

Cisco Finesse does not support the use of Compatibility View with Internet Explorer. If the user is on
Compatibility View the following banner message is displayed on the Finesse Desktop login screen:

The Cisco Finesse Desktop is hot supported in compatibility mode. Contact your administrator to
change the browser settingsto non-compatibility mode and sign in again.

If the user tries to change the compatibility mode after logging in to the Finesse Desktop, an error page is
displayed and the user must sign in to the Finesse Desktop again.

Table 1: Client Operating System

Components Clients 0S

Cisco Finesse Microsoft Windows 10
Mac OS X 10.12, 10.13, and 10.14
ChromeOS 70 (64-bit) and higher

Table 2: Supported Browsers

Operating System Browser Version

Microsoft Windows 10 * Internet Explorer v11.345.17134 or later in Native Mode.

* Google Chrome v76.0.3809 or later.

* Firefox Extended Supported Release (ESR) 68 and later ESRs.
* Edge Chromium (Microsoft Edge v79 and later).

Mac OS X * Firefox Extended Supported Release (ESR) 68 and later ESRs.
* Google Chrome v76.0.3809 or later.

* Edge Chromium (Microsoft Edge v79 and later)

Chromebook with Chrome OS e Chromium v73 or later.

v70
* Google Chrome v60 or later.

For more information, see Contact Center Enter prise Solution Compatibility Matrix at https://www.cisco.com/
c/en/us/support/customer-collaboration/unified-contact-center-enterprise/
products-device-support-tables-list.html.

For more information, see Unified CCX Software Compatibility Matrix at https://www.cisco.com/c/en/us/
support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html.

. Cisco Finesse Installation and Upgrade Guide, Release 12.5(1)


https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html

| Installation Preparation
Network Requirements .

|

Important  Requirements, such as processor speed and RAM, for clients that access the Cisco Finesse desktop can vary.
Desktops that receive events for more than one agent (such as a supervisor desktop running Team Performance
and Queue Statistics gadgets or an agent desktop running Live Data reports that contain information about
other agents or skill groups) require more processing power than desktops that receive events for a single
agent.

Factors that determine how much power is required for the client include, but are not limited to, the following:

* Contact center traffic.
+ Additional integrated gadgets in the desktop (such as Live Data reports or third-party gadgets).

* Other applications that run on the client and share resources with the Cisco Finesse desktop.

Network Requirements

For optimal Finesse performance, network characteristics should not exceed the following threshold:

* Latency: 80 ms (round-trip) between Finesse servers and 400 ms (round-trip) from Finesse client to
Finesse server

For information about bandwidth requirements for Cisco Finesse, see the Cisco Finesse Bandwidth Calculator.

System Account Privileges
During the installation of Cisco Finesse, you must specify credentials for the following:
» Administrator User account: This account is used to access the CLI.
» Application User account: This account is used to access the Finesse administration console.

« Database access security password: This password is required if you replace or add a server in the
future or if you want to replace the security password with a new one. Keep a record of this password.

The database security password and the passwords for the Administrator and Application User accounts must
be at least six characters long. They can contain alphanumeric characters, hyphens, and underscores.

Security Considerations

Cisco Finesse Release 12.0(1) onward, Cross-Origin Resource Sharing (CORS) and Gadget Source Allowed
List are available.

HTTPS Support

Cisco Finesse Release 12.5(1) or higher supports only Secure HTTP (HTTPS) and HTTP is permanently
disabled. If you access Finesse using HTTP (unsecure port: 80 or 8082), then the 301 HTTP redirect status
response is issued to the secure port 8445.

Cisco Finesse Installation and Upgrade Guide, Release 12.5(1) .
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Note

Cisco Finesse Release 12.5(1) or higher supports HTTP/2 protocol by default.

To access the administration console using HTTPS, enter the following URL in your browser:
https://FQDN:8445/cfadmin

Where FQDN is the name of your primary Finesse server and 8445 is the port number.
Similarly, agents and supervisors can access their desktops using HTTPS as follows:
https://FQDN:8445/desktop

To eliminate browser security warnings each time you access the administration console or agent desktop
through HTTPS, you can obtain and upload a CA certificate or you can use the self-signed certificate that is
provided with Finesse.

If you add custom gadgets that perform HTTPS requests to Finesse, you must add a certificate to the Finesse
server for that gadget.

Security Enhancements
Cisco Finesse Release 12.5(1) onward, following security changes are implemented:

* By default, Cisco Finesse Notification Service unsecure XMPP port 5222 and BOSH/WebSocket (HTTP)
port 7071 are disabled.

Use the CLI command utils finesse set_property webservices enablel nsecureOpenfirePort true to
enable these ports.

* Validation of the X.509 certificate is enforced. It is mandatory to have the following valid non-expired
X.509 CA or self-signed certificates, which must be imported into the Cisco Finesse trust store.

* Cisco Finesse node certificates are available by default. The administrator must verify the validity
of the certificates, as non-expired certificates are invalid.

* Valid non-expired Cisco Finesse primary certificate must be present on the secondary Cisco
Finesse.

* Valid non-expired Cisco Finesse secondary certificate must be present on the primary Cisco
Finesse.

* Import the CUCM certificate to both the primary and secondary Finesse nodes.
* Import the IdS certificate to both the primary and secondary Finesse nodes.

* Import the Customer Collaboration Platform server certificates to both the primary and secondary
Finesse nodes in the Unified CCE.

* Import the LiveData server certificates to both the primary and secondary Finesse nodes in the
Unified CCE.

* Import the Cloud Connect server certificates to both the primary and secondary Finesse nodes in
the Unified CCE.

You can override the trust certificate enforcement by using the CLI command utilsfinesse set_property
webservicestrustAllCertificates true.
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For more information on CLI commands, see Cisco Finesse Administration Guide at https://www.cisco.com/
c/en/us/support/customer-collaboration/finesse/products-maintenance-guides-list.html.

Installation Spanning Multiple Domains

You can install the Finesse nodes on separate domains as long as the following requirements are met:

* Each Finesse server can perform a DNS lookup of the other using the fully-qualified domain name
(FQDN).

+ All Finesse clients can perform DNS lookups of the Finesse servers using the FQDN.

Failover Considerations

Cisco Finesse Release 12.5(1) recommends optimal browser and gadget configurations for faster failover.

For more information on deployment practices and guidelines to ensure optimal failover performance, see
Guidelines for Optimal Desktop Failover and Failover Planning sections in Cisco Finesse Administration
Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

For more information on ensuring how the custom gadgets improve failover performance, see Best Practices
for Gadget Devel opment section in Cisco Finesse Web Services Devel oper Guideat https://developer.cisco.com/
docs/finesse/#!rest-api-dev-guide.

For more information on bandwidth measurements, see Finesse Bandwidth Calculator for Unified Contact
Center Enterprise and Cisco Unified Contact Center Express Bandwidth Calculator at https://www.cisco.com/
c/en/us/support/customer-collaboration/finesse/products-technical-reference-list.html.

Other Requirements and Considerations

* Cisco Unified Communications Manager version 12.5 or higher is required to use the Desktop Chat
feature.

* You must have access to a Network Time Protocol (NTP) server.

A

Note From Cisco Finesse Release 12.0(1) onwards, the default desktop notification
connection type is WebSockets.

* You must have a valid hostname and domain.

» It is recommended that you choose the Cisco Finesse hostname, domain and IP address carefully because
changing these configurations after installation requires other steps to be followed, such as: manual
verification of certificate validity, cluster restart, invalidation of the existing backups, and running
commands through the Command Line Interface (CLI).
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Note For more information on the steps to be followed to change the Cisco Finesse
hostname, domain or IP address, see the Manage IP Address and Hostname
chapter in the Cisco Finesse Administration Guide at https://www.cisco.com/c/
en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

Changing the Cisco Finesse hostname, domain or IP address after installation is
supported from Release 12.5(1) ES2 COP.

* You must have a preconfigured default router.
* You must have a preconfigured Domain Name Server (DNS) and have set up forward and reverse DNS.

* Cisco Finesse is supported on a Call Manager Peripheral Gateway (PG) and a Generic PG. Finesse does
not support a System PG. On a System PG, assuming that a Voice Response Unit (VRU) is also set up
for queuing, Finesse would receive queuing events meant for the VRU.

 The Cisco Finesse server uses Windows authentication to access the Administration & Data server
database (AWDB). You can set the MS SQL server authentication mode to either Windows Authentication
or Mixed.

* Cisco Finesse requires a domain user that is configured with login and read permissions to access the
AWDB.

* The Cisco Finesse JDBC driver is configured to use NTLMv2. Therefore, Finesse can connect to the
AWDB even if the AWDB is configured to use only NTLMv2.

* The port for the primary and backup Administration & Data Servers must be the same.

* To ensure secure communication between Finesse and CTI Server, enable the secure mode in the PG.
Also, in the Cisco Finesse Administration Console, enable the option in the CTI Server Settings.

* If you plan to use Cisco Unified Customer Voice Portal (Unified CVP) for queuing, configure Unified
CVP to support warm transfer and conference, as described in the section Using the Warm Transfer
feature with SIP Calls in the Configuration and Administration Guide for Cisco Unified Customer Voice
Portal and the section Network Transfer in the Cisco Unified Customer Voice Portal Solutions Reference
Network Design.

* In Cisco Unified Communications Manager Administration, under Device > Phone, ensure that the
Maximum Number of Calls is set to no more than 2 and Busy Trigger is set to 1.

Preinstallation Tasks

Before you can install Cisco Finesse, complete the following preinstallation tasks:
* Record your network and password information on the configuration worksheet.

» Obtain the installation files.
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Configuration Worksheet

Use this configuration worksheet to record network and password information that is required to install and
configure Finesse. Store this worksheet information for future reference.

\}

Note Many of the values that you enter on the installation configuration screens (such as hostnames, user IDs, and
passwords) are case-sensitive.

Table 3: Configuration Worksheet

Configuration Data Your Entry Notes

Hostname The hostname cannot be “local
host”. The hostname must be
the hostname of the server as

registered in the DNS.
IP Address and Mask
Gateway (GW) Address
Primary DNS IP Address
Secondary DNS IP Address
(optional)
Domain
Administrator User Administrator User ID: This account is used to access
credentials the Finesse CLI.
Administrator User password:
Timezone
Certificate Information Organization:
Unit:
Location:
State:
Country:

NTP Server Host Name or | NTP Server 1:
IP Address

NTP Server 2:

Database Access Security
Password
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Configuration Data

Your Entry

Notes

Application User credentials

Application User ID:

Application User Password:

This account is used to sign in
to the Finesse administration
console.

A Side CTI Server The hostname or IP address of

Hostname/IP Address the A Side CTI server.

A Side CTI Server Port The port of the A Side CTI
server.

B Side CTI Server
Hostname/IP Address

The hostname or IP address of
the B Side CTI server.

B Side CTI Server Port

The port of the B Side CTI
server.

Peripheral ID

The ID of the CallManager
Peripheral Gateway (PG).

Primary Administration &
Data Server Hostname/IP
Address

The hostname or IP address of
the primary Unified CCE
Administration & Data server.

Backup Administration &
Data Server Hostname/IP
Address

The hostname or IP address of
the backup Unified CCE
Administration & Data server.

Database Port

The port of the Unified CCE
Administration & Database
server.

The port must be the same for
the primary and backup
Administration & Data servers.

AW Database Name

The name of the AW Database
(AWDB).

For example,
ucceinstance awdb.

Domain

The domain of the AWDB.
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Configuration Data Your Entry Notes

Username to access the This user refers to the

AWDB Administrator Domain user
that the AWDB uses to

synchronize with the Logger.

The AWDB server must use
Windows authentication and
the configured username must
be a domain user.

Password to access the
AWDB

Hostname/IP address of the
secondary Finesse server

Installation Files

Before you install Cisco Finesse, you must obtain the OVA file. Cisco Finesse supports a single OVA template
with two deployment configurations. Choose the configuration you need based on the size of your deployment.

The filenames for the OVA and associated ReadMe are as follows:
* Finesse 12.5.1 VOSI12.5.1 vmvl3 vl.3.ova
This file is the VM template file that you deploy in your installation.
* Finesse 12.5.1 VOSI12.5.1 vmvl3 vl.3.ova.README.txt
This file contains the instructions to import the OVA file and to edit the VM settings.

* Finesse 12.0.1 VOSI12.0.1 vmv9_vl.2.ova
This file is the VM template file that you deploy in your installation.
* Finesse 12.0.1 VOS12.0.1 vmv9 vl1.2.ova.README.txt
This file contains the instructions to import the OVA file and to edit the VM settings.
You must purchase the Cisco Finesse media kit to obtain the installer. For more information, see the Ordering

Guide for Cisco Customer Contact Solutions
(http://www.cisco.com/web/partners/downloads/partner/ W WChannels/technology/ipc/downloads/CCBU _ordering_guide.pdf).

You can obtain the Cisco Virtual Server (OVA) files needed to create a virtual machine from Cisco.com at
the following URL: http://software.cisco.com/download/type.html?mdfid=283613135&i=rml.
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CHAPTER 2

Cisco Finesse Server Installation

* Installation Task Flow, on page 11

* Install Finesse on Primary Node, on page 11

* Install Finesse on Secondary Node, on page 14
* Installation Troubleshooting, on page 17

Installation Task Flow

The following table provides an overview of the tasks you perform to install Cisco Finesse. Tasks must be
performed in the order they are listed.

1 Install Finesse on the primary node.

2 Configure the database settings.

3 Configure the CTI server settings.

4 Configure the cluster settings for the secondary node.

5 Restart Cisco Finesse Tomcat on the primary node.

6 Install Finesse on the secondary node.

7 Ensure replication is functioning between the two nodes.
8 Install language packs (optional).

Install Finesse on Primary Node

Procedure

Step 1 Follow the instructions in the OVA README.txt file to import and deploy the OVA, to edit VM settings,
and to power on the VM and edit the BIOS settings in the console. For more information, see the section on
Installation Files.
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. Install Finesse on Primary Node

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

Step 9

Step 10

Note Do not use Thin Provisioning or a VM snapshot when creating a VM to host Cisco Finesse. The
use of Thin Provisioning or snapshots can negatively impact the performance of Cisco Finesse
operation.

Messages appear while the preinstallation script runs. When the preinstallation script ends, the DVD Found
screen opens.

Select OK on the Disk Found screen to begin the verification of the media integrity and a brief hardware
check.

If the media check passes, select OK to open the Product Deployment Selection screen. Continue to Step 3.

If the media check fails, the installation terminates.

The Product Deployment Selection screen states that the Cisco Finesse product suite will be installed. This
screen has only one choice: OK.

Select OK to open the Proceed with Install screen.

The Proceed with Install screen shows the version of the product that is currently installed (if any) and the
version of the product for this ISO. For the initial installation, the version currently installed shows NONE.

Select Yes on the Proceed with Install screen to open the Platform Installation Wizard screen.

On the Platform Installation Wizard screen, select Proceed to open the Basic Install screen.
Select Continue on the Basic Install screen to open the Basic Install wizard.

The Basic Install wizard presents a series of screens that present questions and options pertinent to the platform
and the setup configuration. Help is available for each wizard screen.

The first Basic Install wizard screen is Timezone Configuration.

On the Timezone Configuration screen:

a) Use the up and down arrows to locate the local time zone that most closely matches your server location.
You can also type the initial character of the time zone to move to that item in the list. The Timezone field
is based on country and city and is mandatory. Setting it incorrectly can affect system operation.

b) Select OK to open the Auto Negotiation Configuration screen.

On the Auto Negotiation Configuration screen, select Continue to use automatic negotiation for the settings
of the Ethernet network interface card (NIC).

The MTU Configuration screen appears.

In the MTU Configuration screen, select NO to keep the default setting for Maximum Transmission Units
(1500).

Note Finesse supports the default setting of 1500 for MTU only. No other value is supported.

Your selection of No opens the Static Network Configuration screen.

On the Static Network Configuration screen, enter static network configuration values as follows, referring
to the Configuration Worksheet if necessary:

a) Enter the Host Name.

b) Enter the IP Address.

c) Enter the IP Mask.

d) Enter the GW Address.
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Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Step 17
Step 18
Step 19

Step 20

Install Finesse on Primary Node .

e) Select OK to open the Domain Name System (DNS) Client Configuration screen.
On the DNS Client Configuration screen, select Yesto specify the DNS client information.

Important DNS client configuration is mandatory for Cisco Finesse. Select Yes on this screen. If you select
No, after the installation is complete, agents cannot sign in to the desktop and you have to reinstall
Finesse.

Specify your DNS client information as follows, referring to the Configuration Worksheet if necessary:
a) Enter the Primary DNS (mandatory).

b) Enter the Secondary DNS (optional).

¢) Enter the Domain (mandatory).

d) Select OK to open the Administrator Login Configuration screen.

On the Administrator Login Configuration screen:

a) Enter the credentials for the administrator.
b) Select OK to open the Certificate Information screen.

On the Certificate Information screen:

a) Enter the following data to create your Certificate Signing Request: Organization, Unit, Location, State,
and Country.
b) Select OK to open the First Node Configuration screen.

On the First Node Configuration screen, select Yes to indicate that you are configuring the first node.

Your selection of Yes opens the Network Time Protocol Client Configuration screen.

On the Network Time Protocol Client Configuration screen, enter the IP address, NTP server name, or NTP
Server Pool name for at least one external NTP server.

After you complete the NTP configuration, select OK. This action opens the Security Configuration screen.
On the Security Configuration screen, enter the Database Access Security password, and then select OK.

On the Application User Configuration screen, enter the credentials for the application user.

Select OK to open the Platform Configuration Confirmation screen. This screen states that the platform
configuration is complete.

On the Platform Configuration Confirmation screen, select OK.

The installation begins.

The installation can take up to an hour to complete and can run unattended for most of that time.
During the installation, the monitor shows a series of processes, as follows:

* Formatting progress bars

* Copying File progress bar

* Package Installation progress bars

* Post Install progress bar

* Populate RPM Archive progress bar

* Application Installation progress bars (multiple Component Install screens, security checks)

* An informational screen saying the system will reboot momentarily to continue the installation
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If you see the following virtual machine question, select Yes, and then click OK:

Figure 1: Virtual Machine Message

E-EI Yirtual Machine Question

¥irtual Machine Message

msg. cdromdisconnect. locked: The quest operating swstem has locked the CO-ROM doar and is
probably using the CO-ROM, which can prevent the guest From recognizing media changes. If
possible, eject the CD-ROM from inside the guest before disconnecting.

Disconnect anyway (and override the lock)?

" Mo

* A system reboot

Messages stream down your monitor during the reboot. Some of them prompt you to press a key. Do
not respond to these prompts to press a key.

* Application Pre Install progress bars

* Configure and Setup Network progress bars

Note If a Network Connectivity Failure screen appears during the Configure and Setup Network
process, click Review, and then click OK at the Errors screen. Follow the prompts to reenter
the information that caused the failure. The installation continues when the connection
information is complete.

* Security configuration

A message appears that states the installation of Cisco Finesse has completed successfully.

The installation of Cisco Finesse has completed successfully.

Cisco Finesse <version number>
<hostname> login:

What to do next

Sign in to the Finesse administration console on the primary Finesse server (https://FQDN of Finesse
server:8445/cfadmin) to configure CTI server, Administration & Database server, and cluster settings.

After you configure these settings, install Finesse on the secondary node.

Install Finesse on Secondary Node

Install the same version of Finesse on both the primary and secondary Finesse nodes.
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\}

Install Finesse on Secondary Node .

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Note Configure a Datastore ISO file on the virtual CD/DVD drive of the target VM to install Finesse.
)
Note Finesse administration tasks can only be performed on the primary Finesse server. After you install the

secondary server, sign in to the administration console on the primary server to perform administration tasks
(such as configuring reason codes or call variable layout).

Before you begin

« Install Finesse on the primary server. See Install Finesse on Primary Node.

* Use the Finesse administration console on the primary Finesse server to configure CTI server,
Administration & Database server, and cluster settings.

* Ensure that the DNS server has forward and reverse DNS set up for both the primary and secondary
node.

Procedure

Follow the instructions in the OVA README.txt file to import and deploy the OVA, to edit VM settings,
and to power on the VM and edit the BIOS settings in the Console.

Messages appear while the preinstallation script runs. When the preinstallation script ends, the DVD Found
screen opens.

Select Yes on the DVD Found screen to begin the verification of the media integrity and a brief hardware
check.

If the media check passes, select OK to open the Product Deployment Selection screen. Continue to Step 3.

If the media check fails, the installation terminates.

The Product Deployment Selection screen states that the Cisco Finesse product suite will be installed. This
screen has only one choice: OK.

Select OK to open the Proceed with Install screen.

The Proceed with Install screen shows the version of the product that is currently installed (if any) and the
version of the product for this ISO. For the initial installation, the version currently installed shows NONE.

Select Yes on the Proceed with Install screen to open the Platform Installation Wizard screen.
On the Platform Installation Wizard screen, select Proceed to open the Basic Install screen.
Select Continue on the Basic Install screen to open the Basic Install wizard.

The Basic Install wizard presents a series of screens that present questions and options pertinent to the platform
and the setup configuration. Help is available for each wizard screen.

The first Basic Install wizard screen is Timezone Configuration.

In the Timezone Configuration screen:
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Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Step 17

a) Use the up and down arrows to locate the local time zone that most closely matches your server location.
You can also type the initial character of the time zone to move to that item in the list. The Timezone field
is based on country and city and is mandatory. Setting it incorrectly can affect system operation.

b) Select OK to open the Auto Negotiation Configuration screen.

On the Auto Negotiation Configuration screen, select Continue to use automatic negotiation for the settings
of the Ethernet network interface card (NIC).

The MTU Configuration screen appears.

On the MTU Configuration screen, select NO to keep the default setting for Maximum Transmission Units
(1500).

Note Finesse supports the default setting of 1500 for MTU only. No other value is supported.

Your selection of No opens the Static Network Configuration screen.

On the Static Network Configuration screen, enter static network configuration values as follows, referring
to the Configuration Worksheet if necessary:

a) Enter the Host Name.

b) Enter the |IP Address.

¢) Enter the IP Mask.

d) Enter the GW Address.

e) Select OK to open the Domain Name System (DNS) Client Configuration screen.

On the DNS Client Configuration screen, select Yesto specify the DNS client information.

IMPORTANT: DNS client configuration is mandatory for Cisco Finesse. Select Yes on this screen. If you
select No, after the installation is complete, agents cannot sign in to the desktop and you have to reinstall
Finesse.

Specify your DNS client information as follows, referring to the Configuration Worksheet if necessary:
a) Enter the Primary DNS (mandatory).

b) Enter the Secondary DNS (optional).

¢) Enter the Domain (mandatory).

d) Select OK to open the Administrator Login Configuration screen.

On the Administrator Login Configuration screen:

a) Enter the credentials for the administrator.

b) Select OK to open the Certificate Information screen.
On the Certificate Information screen:

a) Enter the following data to create your Certificate Signing Request: Organization, Unit, Location, State,
and Country.
b) Select OK to open the First Node Configuration screen.

On the First Node Configuration screen, select NO to indicate that you are configuring the second node.

A warning message appears that indicates you must first configure the server on the first node before you can
proceed. If you already configured the first node, select OK.

On the Network Connectivity Test Configuration screen, select NO to proceed with the installation after
connectivity is verified.

On the First Node Configuration screen, specify the information about the first node as follows:
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Step 18
Step 19

Installation Troubleshooting .

a) Enter the Host Name of the primary Finesse server.

b) Enter the |P Address of the primary Finesse server.

c) Enter the Security Password of the primary Finesse server.
d) Confirm the Security Password.

Select OK to open the Platform Configuration Confirmation screen.

On the Platform Configuration Confirmation screen, select OK.
The installation begins.
The installation can take up to an hour to complete and can run unattended for most of that time.

A message appears that states the installation of Cisco Finesse has completed successfully.

The installation of Cisco Finesse has completed successfully.

Cisco Finesse <version number>
<hostname> login:

What to do next

Check the replication status. If all nodes in the cluster show a replication statusof 2, replication is functioning
correctly.

It can take 10—20 minutes to establish replication fully between the two nodes.

To access platform specific applications like Disaster Recovery System, Cisco Unified Serviceability, and
Cisco Unified Operating System Administration, use the following URL, https://FQDN of Finesse server:8443.

Installation Troubleshooting

If Then

The installation fails. If the installation fails, a screen appears that asks if you want to copy
diagnostic information to a device.

In this situation, you must reinstall from the beginning, but first you must
attach a serial port to the VM. Then, you dump the install logs into the
serial port of the VM.
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Upgrade

* Supported Upgrade Paths, on page 19
* Aligned Partitions Support, on page 19
* Perform Upgrade, on page 20

* Perform Rollback, on page 22

Supported Upgrade Paths

The following table list the supported upgrade path to Cisco Finesse Release 12.5(1).

Current Version Upgrade Path

Release 12.0(x) Upgrade to Release 12.5(1)

Note To perform an upgrade of Cisco Finesse to 12.5(1),
you must first perform an upgrade to 12.0(1) from
the previous versions and then upgrade to 12.5(1).

\}

Note Cisco Finesse ISOs are bootable. For example, if you must rebuild your secondary server, you can upgrade
your primary server to the latest release and then perform a fresh installation with the Finesse ISO on your
secondary server.

Aligned Partitions Support

Cisco Finesse Release, 12.5(1) supports aligned partitions with a fresh installation.

If you perform an upgrade from a previous release, the platform detects the unaligned partitions and displays
the following error:

ERROR-UNSUPPORTED: Partitions unaligned

You can run Cisco Finesse with the unaligned partitions, as there is no functional impact to Finesse. However,
you cannot experience the benefits of aligned partitions unless you perform a fresh installation.

To support aligned partitions following an upgrade, do the following:
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Upgrade Cisco Finesse to Release 12.5(1).

Perform a backup on the primary Finesse server using the Disaster Recovery System (DRS) application.
To access the DRS application, direct your browser to https://FQDN of Finesse server:8443/drf.

Perform a fresh installation of Cisco Finesse Release 12.5(1).

Access the DRS application and perform a restore from your backup.

For more information about DRS backup and restore, see the Cisco Finesse Administration Guide and the
detailed online help provided with the DRS application.

Perform Upgrade

You must perform the upgrade on the primary Finesse node first, and then on the secondary Finesse node.
Both the primary and secondary Finesse nodes must be running the same version prior to the upgrade.

Before you begin

*» Upgrade Finesse during off-peak hours or during a maintenance window to avoid service interruptions.

* Perform a DRS backup on the primary Finesse server. To access the DRS application, direct your browser
to https://FQDN of Finesse server:8443/drf. For more information, see the online help provided with the
DRS application.

* For large deployments, allocate extra vVRAM and other resources to avoid impacting the performance of
the upgraded version. For more information on the virtualization details, see https://www.cisco.com/c/
dam/en/us/td/docs/voice ip_comm/uc_system/virtualization/virtualization-cisco-finesse.html.

* Place the Cisco Finesse ISO file on an FTP or SFTP server that you can access from your Finesse system
or burn the ISO file to DVD.

* From the Cisco Finesse release 12.0(1), the Administration Console has a new look and feel. If you have
a custom desktop layout, save your current layout configuration. Sign in to the administration console
on the primary Finesse node (https://FQDN of Finesse server:8445/cfadmin). Copy the layout XML file
from the Manage Desktop Layout gadget on the Desktop Settings tab and save it as a text file on your
local system.

* Icons (both custom and in-built) that appear on the Finesse desktop and the left navigation bar are now
customizable. Finesse specific tabs with no change in labels, will automatically display their respective
in-built icons. Tabs which are created or modified will have a default icon. Customizing these icons can
be done in the desktop layout through the administration portal of Finesse. Custom icons can be uploaded
into the finesse 3rdpartygadget. For more information see, Default Layout XML section in Cisco Finesse
Administration Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

* For upgraded layouts, the "hidden=false" attribute will be introduced for non voice state control gadgets.
For example, the existing non voice control gadget URLs will be migrated to the new URL <gadget
hidden="true" >https:.//localhost/uccx-nvcontrol/gadgets’NonVoiceContr ol .xml</gadget>

* For upgraded layouts, TeamMessage, Desktop Chat, and sample configurations for customizing desktop
properties do not appear by default. The administrator must copy the XML from the View Default L ayout
and add to the respective custom layouts. For more information, see Cisco Finesse Administration Guide

. Cisco Finesse Installation and Upgrade Guide, Release 12.5(1)


https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-finesse.html
https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-finesse.html
https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-maintenance-guides-list.html
https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-maintenance-guides-list.html

| Upgrade

Perform Upgrade .

at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

» maxRow is changed from being a query parameter to an attribute. During an upgrade it will be removed
from the URL of the Team Performance gadget and will be added as an attribute. Post upgrade, the height
of the rows in the Team Performance gadget remain the same.

* In upgrade scenarios, by default, the first two call variables will be displayed in the agent call popover
and supervisor active call details. You can modify the configuration of the popover variables to improve
the agent and supervisor experience.

* After upgrades, manually remove the Context Service gadgets from the Desktop Layout and Team
Desktop Layout.

\}

Note  After the successful upgrade, the CAs that are unapproved by Cisco are removed from the platform trust store.
However, you can add them back, if necessary.

» For information about the list of CAs that Cisco supports, see the Cisco Trusted External Root Bundle
at https://www.cisco.com/security/pki.

« For information about adding a certificate, see Insert a New Tomcat-trust Certificate section in the CUCM
Certificate Management and Change Notification at https://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/products-tech-notes-list.html.

Procedure
Step 1 SSH to your Finesse system and sign in with the platform administration account.
Step 2 Access the CLI and run the command utils system upgradeinitiate.
Step 3 Follow the instructions provided by the utils system upgrade initiate command.

If you choose to install from a remote source (FTP or SFTP server), provide the location and credentials for
the remote file system.

If you choose to install from the local CD/DVD drive, ensure the drive is connected to the Finesse virtual
machine (VM) as follows:

a) Right-click the VM and choose Edit Settings.

b) Click the Hardware tab.

¢) In the left pane, select CD/DVD Drive.

d) In the right pane, under Device Status, check the Connected and Connect at power on check boxes.
e) Under Device Type, select Datastore | SO File.

f) Click Browse and navigate to the Finesse ISO file.

g) Click OK.

Finesse also prompts you for SMTP Server information, but it is not mandatory. You can skip the SMTP
prompt if you do not have an SMTP Server.

Step 4 At the Automatically switch versionsif the upgrade is successful prompt, type yes. The upgrade is not
active until a switch version is performed.
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Step 5
Step 6

Step 7

Step 8
Step 9

Upgrade |

Note Once the switch version is complete, the system will reboot.

At the Start installation (yes/no) prompt, type yesto start the upgrade.

If you are installing from the local CD/DVD drive, when the upgrade enters the BIOS screen, on the Boot
tab, move CD-ROM Dirive to the top, save your settings, and exit.

After the upgrade is complete, disconnect the CD/DVD drive.

a) Right-click the VM and choose Edit Settings.

b) Click the Hardware tab.

¢) Select CD/DVD Drivel.

d) Uncheck the Connected and Connect at power on check boxes.
e) Click OK.

Perform the preceding steps on the secondary Finesse server.

Sign in to the Finesse desktop to verify that the upgrade was successful (https://FQDN of Finesse
server:8445/desktop).

Note After Finesse restarts, wait approximately 20 minutes before you attempt to sign in to the desktop.
Finesse services may take a few minutes to reach the STARTED state.

What to do next
After a system upgrade, make sure all agents, supervisors, and administrators clear their browser cache.

If you had a modified desktop layout before the upgrade, perform the following steps to ensure you obtain
the latest changes:

1. Sign in to the Finesse administration console and click the Desktop L ayout tab.
2. On the Manage Desktop Layout gadget, click Restore Default L ayout.
3. Click Save.
4

Using the text file of the desktop layout that you saved before the upgrade as a reference, modify the
layout to include the changes that you made to the previous layout.

5. Click Saveto save your changes.
In the Manage Reasons (Not Ready) gadget, check for Not Ready reason codes with code values that are not
unique. Edit any that you find to give them unique values.

In the Manage Reasons (Sign Out) gadget, check for Sign Out reason codes with code values that are not
unique. Edit any that you find to give them unique values.

Perform Rollback

If a problem occurs with the upgrade, you can roll back to the earlier release.
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Procedure

Step 1 Perform a switch-version on the primary node.

a) Access the CLI and enter the command utils system switch-version.
b) Enter yesto confirm.

The system attempts to switch back to the original version and reboots if the switch is successful.

Step 2 Repeat Step 1 on the secondary node.

Step 3 1 hour after the switch version is complete, use the following command on both nodes to confirm that the
replication is successful: utilsdbreplication runtimestate.

The replication is successful if the output shows a replication status of 2.

Note If the replication is unsuccessful, run the following database replication commands on the primary
node:

utils dbreplication stop all
utils dbreplication reset all

After you enter these commands, wait again for 1 hour (or more depending on the volume of data)
before again using the utils dbreplication runtimestate command to confirm the replication is
successful.
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CHAPTER 4

Initial Configuration

* Configure Contact Center Enterprise Administration & Data Server Settings, on page 25
* Configure Contact Center Enterprise CTI Server Settings, on page 26

* Configure Cluster Settings, on page 27

* Restart Cisco Finesse Tomcat, on page 27

* Check Replication Status, on page 28

* Install Language Pack, on page 28

* Configure IPv6 Settings, on page 29

» Ensure Agents Have Passwords, on page 30

* Ensure Logout Non-Activity Time for Agents is Configured, on page 31
* Configure Agent Phones, on page 31

* Configure Finesse IP Phone Agent, on page 31

» Browser Settings for Agent and Supervisor Desktop, on page 32

* Ensure Agents Can Sign in to Desktop, on page 32

* Ensure Failover Functions Correctly, on page 33

* Configure DNS on Clients, on page 34

* Cloud Connect Certificates, on page 35

* Customer Collaboration Platform Certificates, on page 36

* Load Balancing for Finesse, on page 38

* Initial Configuration Troubleshooting, on page 39

Configure Contact Center Enterprise Administration & Data
Server Settings

Configure the Contact Center Enterprise Administration & Data Server settings to enable authentication for
Finesse agents and supervisors.

N

Note If you are using HTTPS, the first time you access the administration console, you see a browser security
warning. To eliminate browser security warnings each time you sign in, you can trust the self-signed certificate
provided with Finesse or obtain and upload a CA certificate.
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Procedure
Step 1 Sign in to the administration console.
Step 2 In the Contact Center Enterprise Administration & Data Server Settings area, enter the Administration & Data

Server settings as described in the following table. Refer to your configuration worksheet if necessary.

Field Description

Primary Host/IP Address Enter the hostname or IP address of the Unified CCE Administration
& Data Server.

Backup Host/IP Address Enter the hostname or IP address of the backup Unified CCE
Administration & Data Server.

Database Port Enter the port of the Unified CCE Administration & Data Server.
Note Because Finesse expects the primary and backup

Administration & Data Server ports to be the same, the
Finesse administration console exposes only one port field.
You must ensure that the port is the same for the primary
and backup Administration & Data Servers.

AW Database Name Enter the name of the AW Database (AWDB) (for example,
ucceinstance awdb).

Domain Enter the domain of the AWDB.

Username Enter the username required to sign in to the AWDB.

Password Enter the password required to sign in to the AWDB.

Step 3 Click Save.

Configure Contact Center Enterprise CTI Server Settings

Configure the A Side and B Side CTI servers on the primary Finesse server.

Procedure

Step 1 If you are not already signed in, sign in to the administration console on the primary Finesse server:

https://FQDN of Finesse server/cfadmin

Step 2 Sign in with the Application User credentials defined during installation.

Step 3 In the Contact Center Enterprise CTI Server Settings area, enter the CTI server settings as described in the
following table. Refer to your configuration worksheet if necessary.
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Field Description

A Side Host/IP Address Enter the hostname or IP address of the A Side CTI server.
This value is typically the IP address of the Peripheral Gateway (PG).
The CTI server runs on the PG.

A Side Port Enter the port number of the A Side CTI server. The value of this
field must match the port configured during the setup of the A Side
CTI server.

Peripheral ID Enter the ID of the Agent PG Routing Client (PIM).

The Agent PG Peripheral ID should be configured to the same value
for the A Side and B Side CTI servers.

B Side Host/IP Address

Enter the hostname or IP address of the B Side CTI server.

B Side Port

Enter the port of the B Side CTI server. The value of this field must
match the port configured during the setup of the B Side CTI server.

Enable SSL encryption

Check this box to enable secure encryption.

Step 4 Click Save.

Configure Cluster Settings

Configure the cluster settings for the secondary Finesse node. The secondary Finesse node handles agent
requests if the primary server goes down.

Procedure

Step 1 If you are not already signed in the primary node, sign in to the administration console of the primary node

with the Application User credentials.

Step 2 In the Cluster Settings area, in the Hostname field, enter the hostname of the secondary Finesse server.

Step 3 Click Save.

Restart Cisco Finesse Tomcat

After you make changes to the Contact Center Enterprise CTI Server, Contact Center Enterprise Administration
& Data Server, or cluster settings, restart Cisco Finesse Tomcat for the changes to take effect.
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\}

Note

Step 1

Step 2

After you restart Finesse, it can take approximately 6 minutes for all server-related services to restart. Therefore,
you wait 6 minutes before you attempt to access the Finesse administration console.

Procedure

Access the CLI and run the following command:

utils servicerestart Cisco Finesse Tomcat

You can enter the command utils servicelist to monitor the Cisco Finesse Tomcat Service. After Cisco Finesse
Tomcat changes to STARTED, the configured agents can sign in to the desktop.

Check Replication Status

Step 1
Step 2
Step 3

Procedure

Access the CLI on the primary Finesse server.
Sign in with the Administrator User credentials that are defined during installation.
Run the following command:

utils dbreplication runtimestate

This command returns the replication status on both the primary and secondary Finesse servers.

Install Language Pack

Download and install a language pack only if you want to use the Finesse desktop interface in a language
other than English.

The language pack for Finesse is delivered as a single Cisco Option Package (COP) file. The file is available
to download from Cisco.com and contains a single installer for all language variants.

You can download the language pack for Finesse at the following link:

https://software.cisco.com/download/
release.html?mdfid=283613135&softwareid=284259728 &relind=AVAILABLE&rellifecycle=&reltype=latest

COP files can generally be installed on an active, running system. However, language COP files cannot be
removed or rolled back.
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\}

Configure IPv6 Settings .

Note

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

If the ReadMe file for a specific COP file contradicts these general guidelines, follow the instructions provided
with the file.

For more information about supported languages, see the Cisco Finesse Administration Guide
(https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-user-guide-list.html).

Procedure

Download the Finesse COP file from the Cisco Software site https://software.cisco.com/download/
type.html?mdfid=283613135&i=rm to a local source or an SFTP server that can be accessed by the Finesse
server.

Use SSH to log in to your Finesse system with the platform administration account.
Use the CLI to run the command utils system upgrade initiate.

Follow the instructions provided by the utils system upgrade initiate command.
Reboot the server.

Repeat step 2 through step 5 on the secondary Finesse server.

When the installation is complete on both Finesse servers, agents and supervisors must clear their browser
cache and cookies.

Configure IPv6 Settings

Cisco Finesse supports IPv6 using dual stack (IPv4 and IPv6). By default, only IPv4 is enabled at installation.
You can enable IPv6 after installation using either Cisco Unified Communications Operating System
Administration or the CLI.

With IPv6 enabled, the Finesse Administration Console, Finesse Desktop Interface, and Finesse REST APIs
can connect to the Finesse server using IPv4 or IPv6. However, the Finesse server can connect to Unified
CCE and the CTI server using [Pv4 only.

When you set up IPv6 on Finesse, restart the system for the updates to take effect.

Set Up IPv6 Using Cisco Unified Communications Operating System
Administration

Step 1

To set up IPv6 using Cisco Unified Operating System Administration, perform the following procedure on
both the primary and secondary Finesse servers.

Procedure

Sign in to Cisco Unified Operating System Administration on the Finesse server
(https://FQDN:8080/cmplatform, where FQDN is the fully qualified domain name of the Finesse server).
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Step 2 Navigate to Settings> |P > Ethernet | Pv6.

Step 3 To enable IPv6, check the Enable I Pv6 check box (or uncheck the box to disable IPv6).
Step 4 Enter values for | Pv6 Address, Prefix Length, and Default Gateway.

Step 5 To restart after you save the changes, check the Update with Reboot check box.

Step 6 Click Save.

Set Up IPv6 Using the CLI

To set up IPv6 using the CLI, perform the following procedure on both the primary and secondary Finesse
servers.

Procedure

Step 1 Access the CLI on the Finesse server.
Step 2 To enable or disable IPv6, enter:
set network ipv6 service {enable | disable}

Step 3 Set the IPv6 address and prefix length:
set network ipv6 static_address addr mask

Example:

set network ipv6 static address 2001:db8:2::a 64
Step 4 Set the default gateway:

set network ipv6 gateway addr

Step 5 Restart the system for the changes to take effect.
utils system restart

Step 6 To display the IPv6 settings, enter:
show network ipv6 settings

Ensure Agents Have Passwords

Agents who do not have a password defined in Unified CCE Configuration Manager cannot sign in to Finesse.
Agent password is an optional field in Unified CCE, but it is mandatory for Cisco Finesse.

For agents who do not have passwords, you must perform the following steps:

Procedure

Step 1 Launch Unified CCE Configuration Manager.
Step 2 Locate the record for the agent (Agent Explorer > Agent tab).
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Step 3

Ensure Logout Non-Activity Time for Agents is Configured .

Enter a password, and save the record.

Ensure Logout Non-Activity Time for Agents is Configured

Step 1
Step 2
Step 3
Step 4

Step 5

The Logout non-activity time specifies how long an agent can remain inactive in the Not Ready state before
that agent is signed out of Finesse.

Perform the following steps to configure Logout non-activity time for an agent.

Procedure

Launch the Unified CCE Configuration Manager.
Launch Agent Desk Settings List (Tools> List Tools).
Select Agent Desk SettingsList.

In the Logout non-activity time field, enter the number of seconds of agent inactivity while in the Not Ready
state before the system software signs the agent out. You can enter a value between 10 seconds and 7200
seconds.

Click Save.
The modified settings are applied to all of the agents who use these agent desktop settings.

Configure Agent Phones

Before agents can sign in to the Finesse desktop, you must ensure that the agent phones are configured in
Unified Communications Manager. For more information about configuring agent phones, see the “Agent
Phones” section of the Cisco Unified Contact Center Enterprise Design GuideSolution Design Guide for
Cisco Unified Contact Center Enterprise (https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-implementation-design-guides-list.html).

Configure Finesse IP Phone Agent

\}

With Finesse IP Phone Agent (IPPA), agents and supervisors can access Finesse features on their Cisco IP
Phones as an alternative to accessing Finesse through the browser. Finesse IPPA supports fewer features than
the Finesse desktop in the browser, but it does allow agents and supervisors to receive and manage Finesse
calls if they lose or do not have access to a computer.

To set up Finesse IPPA, see the Cisco Finesse Administration Guide (https://www.cisco.com/c/en/us/support/
customer-collaboration/finesse/products-user-guide-list.html).

Note

The Finesse IPPA setup requires a Cisco Finesse Tomcat restart.
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Browser Settings for Agent and Supervisor Desktop

To ensure that all features of the Cisco Finesse agent and supervisor desktop work properly, you must disable
popup blockers from the following supported browsers:

* Internet Explorer v11.345.17134 or later in Native Mode.

Apart from disabling popup blockers, to configure the privacy and advanced settings in Internet Explorer,
go to Tools> I nternet Options> Privacy. Enter the domain name of Side A and B Finesse servers, and
click Allow.

* Google Chrome v76.0.3809 or later.

N

Note Ensure to disable the Automatic tab discarding feature in Chrome (version 74
and earlier) to avoid exiting the Cisco Finesse desktop tab when the system
memory is low.

* Firefox Extended Supported Release (ESR) 68 and later ESRs.
* Edge Chromium (Microsoft Edge v79 and later).

Ensure Agents Can Sign in to Desktop

After the system administrator defines configuration settings and restarts services, agents who have passwords
and operational handsets can sign in to the Finesse Agent Desktop.

\}

Note Finesse agents can enter either their AgentID or Login name (in the Username field of the desktop login
screen) to sign in. Ensure that each agent's Agent 1D and Login name are unique across both sets of data. If
one agent's Agent ID matches another agent's Login name, neither agent can sign in.

)

Note  After you restart Finesse, it takes approximately 6 minutes for all server-related services to restart. Therefore,
you should wait 6 minutes before you attempt to sign in to the desktop.

\}

Note If you are using HTTPS, the first time you access the agent desktop, you see a browser security warning. To
eliminate browser security warnings each time you sign in, you can trust the self-signed certificate provided
with Finesse or obtain and upload a CA certificate.
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Step 1

Step 2

Step 3

Step 4

Ensure Failover Functions Correctly .

Procedure

Enter the following URL in the address bar of your browser:
https://FQDN of Finesse server/desktop

If you installed the language pack COP file, on first login, select the language you want to appear on the
desktop from the drop-down menu in the language selector screen and click Next. If you did not install the
language pack COP file, the language selector drop-down list does not appear in the user interface.

Note If you installed the language pack COP file, you can also select a language by passing the locale as
part of the URL (for example, https://FQDN of Finesse server/desktop?locale=fr FR) or by changing
your browser preferred language. The default language is English (en_US).

Enter your username, password, and extension, and then click Sign In.

Note The Sign In button is enabled once the username, password and extension fields are entered. If any
field is incomplete, the Sign In button will remain disabled.

If you wish to change the language that appears on your desktop, use the Changethe L anguage link to return
to the language selector screen and choose the language.

If your agent is signed into the Agent Desktop in Single Sign-On Mode or Hybrid Mode, refer to the sections
Sgn In to Finesse Desktop Single Sgn-On Mode or Sign In to Finesse Desktop Hybrid Mode in the Cisco
Finesse Desktop User Guide for Unified Contact Center Enterprise.

Ensure Failover Functions Correctly

\)

Finesse provides a diagnostic tool that you can run on the Finesse desktop to ensure that failover is functioning
correctly.

Note

Step 1
Step 2

For this tool to make an accurate diagnosis, the alternate Finesse server must be accessible and in service

Procedure

Sign in to the Finesse desktop.
Enter the following URL in the address bar of the browser:

https://FQDN of Finesse server/desktop/failover

The tool performs a simulated failover test and displays the results. If the test passes, the following message
appears:

Test sequence passed for failover to <Finesse alternate server name>. Click OK to test failback by running
the test sequence from <Finesse alternate server name>.
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Step 3

Click OK to test failback.

Note If the failover test fails, the server may not be accessible (for example, certificate exceptions may
be blocking browser access). To ensure that this is not the case, try to access the alternate Finesse
server directly using the FQDN and manually sign in to the desktop. If sign-in succeeds, certain
browser settings or policies may be preventing failover from working properly. For example,
accessing Finesse with its hostname or IP address instead of the FQDN may cause browsers to place
client-side security restrictions on access between the two servers because they are considered to
be third-party to each other. If the two servers are on the same domain and accessed with the FQDN,
these restrictions are not as strict.

Configure DNS on Clients

N

Note

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

This procedure is required for uncommon environments where non-hierarchical DNS configuration exists. If
your environment has hierarchical DNS configuration, you do not need to perform this procedure. This
procedure applies to clients that use a Windows operating system. For information about configuring DNS
on Mac clients, see your Apple documentation (www.apple.com/mac).

Configuring DNS on client computers allows the clients to resolve the fully-qualified domain name (FQDN)
of the active Finesse server during a failover.

Procedure

Go to Control Panel > Network and Internet > Network and Sharing Center. (Open the Control Panel,
enter Network Connections in the search bar, and then click View network connections.)

Click the appropriate network connection.
A dialog box showing the status of the connection appears.

Click Properties.

On the Networking tab, select Internet protocol version 4 (TCP/IPv4) or Internet protocol version 6 (TCP/IPv6)
if the client is IPV6, and then click Properties.

Click Advanced.

On the DNS tab, under DNS server addresses, in order of use, click Add.

Enter the IP address of the DNS server that was entered during installation and click Add.

If a secondary DNS was entered during installation, repeat Step 5 and Step 6 to add its IP address.
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Cloud Connect Certificates

Import Cloud Connect certificates to the trust store of Finesse to communicate with the Cloud Connect server
using HTTPS. You must import a valid non-expired X.509 CA or self-signed certificate into the Cisco Finesse
trust store.

* For a CA-signed certificate, see CA-Signed Certificate, on page 35.

* For a self-signed certificate, see Self-Signed Certificate, on page 35.

CA-Signed Certificate

Procedure

Step 1 Obtain the CA-signed certificate from the certification authority for Cloud Connect server.
a) Sign in to Cisco Unified OS Administration on the Cloud Connect server using the following URL:
https://FQDN of Cloud Connect server:8443/cmplatform.

b) Generate the CSR and sign it from the certification authority. For more information on generating the
CSR, see the Certificate Management section in the Getting Sarted chapter of Cisco Finesse
Administration Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

Step 2 Import the CA-signed certificate of Cloud Connect server to the Cisco Finesse server trust store as tomcat-trust.
For more information, see Import Cloud Connect Certificate, on page 36.

Self-Signed Certificate

Procedure

Step 1 Export the self-signed Cloud Connect certificate from the Cisco Unified Operating System Administration.
For more information, see Export Cloud Connect Certificate, on page 35.

Step 2 Import the downloaded self-signed Cloud Connect certificate to the Cisco Finesse trust store as tomcat-trust.

For more information, see Import Cloud Connect Certificate, on page 36.

Export Cloud Connect Certificate

Procedure

Step 1 Sign in to Cisco Unified OS Administration on the Cloud Connect server using the following URL:
https://FQDN of Cloud Connect server:8443/cmplatform.
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Step 2
Step 3

Step 4
Step 5

Select Security > Certificate M anagement.

Enter the search criteria as tomecat and then click Find to filter the certificate.

The tomcat certificates list is displayed. If you do not find the tomcat certificate for your server in the Certificate
List, then click Generate Self-signed. When the certificate generation is complete, reboot your server. Then
restart this procedure. For more information on generating the self-signed certificate, see Cisco Unified
Operating System Administration Online Help.

Click Download .PEM File.

Save the .PEM file in your local machine.

What to do next

Follow the same steps for both publisher and subscriber nodes.

Import Cloud Connect Certificate

Step 1

Step 2
Step 3

Step 4

Before you begin

Export tomcat certificate for all Cloud Connect nodes and save in your local machine. For more information,
see Export Cloud Connect Certificate.

Procedure

Sign in to Cisco Unified OS Administration on the primary Finesse server using the following URL:
https://FQDN of Finesse server:8443/cmplatform

Select Security > Certificate Management > Upload Certificate/Certificate chain.
Upload the Cloud Connect certificate.

a) From the Certificate Purpose drop-down list, select tomcat-trust.
b) Inthe Upload File field, click Browse and browse to the Cloud Connect certificate file.
¢) Click Upload.

Reboot the Cisco Finesse server.

Customer Collaboration Platform Certificates

You can develop applications using Customer Collaboration Platform and Cisco Finesse APIs in order to use
Task Routing. The Customer Collaboration Platform Task API enables applications to submit non-voice task
requests to Unified CCE. Cisco Finesse uses Customer Collaboration Platform APIs for task management.

Cisco Finesse Release 12.5(1) onwards, validation of the X.509 certificate is enforced. It is mandatory to have
a valid non-expired Customer Collaboration Platform X.509 CA or self-signed certificate to be imported into
the Cisco Finesse trust store.

The administrator must set the utilsfinesse set_property webservicestrustAllCertificatesto falseto enable
the validation of the X.509 CA or the self-signed certificate.
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For more information on CLI commands, see Service Properties section in Cisco Finesse Administration
Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/
products-maintenance-guides-list.html.

Export Customer Collaboration Platform

Before you begin

Add the Customer Collaboration Platform IP address to the allowed list addresses.

Procedure

Step 1 Sign in to Cisco Unified OS Administration on the CUCM server using the following URL: https://FQDN
of Customer Collaboration Platform server/cmplatform.

Step 2 Select Security > Certificate M anagement.

Step 3 Enter the search criteria as tomcat and then click Find to filter the certificate.
The tomcat certificates list is displayed. If you do not find the tomcat certificate for your server in the Certificate
List, then click Gener ate Self-signed. When the certificate generation is complete, reboot your server. Then

restart this procedure. For more information on generating the self-signed certificate, see Cisco Unified
Operating System Administration Online Help.

Step 4 Click Download .PEM File.
Step 5 Save the .PEM file in your local machine.

What to do next

Follow the same steps to export the certificate for all the CUCM nodes.

Import Customer Collaboration Platform Certificate

Procedure

Step 1 Sign in to Cisco Unified OS Administration on the Finesse server using the following URL: https://FQDN
of Finesse server: 8443/cmplatform
Step 2 Select Security > Certificate Management > Upload Certificate/Certificate chain.
Step 3 Upload the Customer Collaboration Platform certificate.
a) From the Certificate Purpose drop-down list, select tomcat-trust.
b) Inthe Upload File field, click Browse and browse to the Customer Collaboration Platform certificate
file.
¢) Click Upload .

Note Configure Customer Collaboration Platform in Unified CCE and Unified CCX using the
fully-qualified domain name (FQDN).
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Step 4
Step 5

After the upload is complete, sign out from the platform administration page of Cisco Finesse.

Reboot the Cisco Finesse server.

Note Follow the same steps to upload the Customer Collaboration Platform certificate on both the primary
and secondary Finesse nodes.

Load Balancing for Finesse

After agents sign in to the Finesse desktop, the Finesse desktop client manages failover. For example, if a
Finesse server goes out of service, the Finesse client automatically redirects and signs the agent in to the other
Finesse server. The client can manage various network and server failure use cases. Given this client-side
logic, the use of a load balancer after sign-in is not required nor supported.

However, the following are two scenarios in which you can use a load balancer with Finesse.

Note

These scenarios only apply to the Finesse desktop and not to Finesse IP Phone Agents.

When Agents Navigate to the Finesse Sign-In Page

If an agent attempts to navigate to a Finesse server that is down or not reachable, they cannot access the sign-in
page. The agent receives an error and must manually sign in to the other Finesse server. To avoid this manual
step, customers can use a load balancer using URL redirect mode to direct the agent to a Finesse server that
is operational. One option is to use the Finesse SystemInfo REST API, which provides the status of the Finesse
server. For details about this API, see the Cisco Finesse Web Services Developer Guide.

When you configure a load balancer to determine the status of the Finesse servers, the call flow is as follows:
1. When agents sign in to Finesse, they point their browsers to the load balancer.
2. The load balancer redirects the agent browser to an appropriate Finesse server.

3. The agent signs in to the Finesse server directly. At this stage, the load balancer is no longer part of the
call flow.

When Customers Use the Finesse APl Directly

If a customer uses the Finesse REST API directly, the Finesse client-side failover logic is not in the call flow.
In this case, customers can opt to use a load balancer to manage high availability. This load balancer is
considered part of a custom application which, like all custom applications, Cisco does not support. The
customer or partner must provide the required support for the load balancer.

Before you configure the load balancer, remember that there are two connections between Finesse clients and
the Finesse server:

» A REST channel for request and response

« An XMPP channel that the server uses to send notifications to the client

Both channels for a given client must connect to the same Finesse server.
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You cannot connect the load balancer to the REST connection for one Finesse server and to the XMPP channel
connection for the other Finesse server. This setup provides unpredictable results and is not supported.

Initial Configuration Troubleshooting

If Then

The administration console does |1. Clear your browser cache (delete browsing history and cookies).

not load after a fresh installation. . . . .
2. If the problem persists, restart the Cisco Finesse Tomcat service or

restart the Finesse server.
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If

Then

Agents cannot sign in to the
desktop after a fresh installation.
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Then

1

Verify that the agent ID and password are correct.

Note Finesse agents can use either their 1oginID Or loginName
to sign in. Ensure that each agent's 10ginID and
loginName are unique across both sets of data. If one
agent's 1oginID matches another agent's 1oginName,
neither agent can sign in.

Verify that a valid domain was configured during installation and
that forward and reverse DNS are set up correctly. To check whether
DNS was configured during installation, check the install.log for
the following:

InstallWizardlUSER_ACTION BTN PUSH: Screen=DNS Client
Configuration, button pushed = No|<LVL::Info

The preceding message indicates that DNS was not configured during
the installation. Reinstall Finesse and configure the DNS with a valid
domain.

Verify that the agent is configured in Unified CCE.
Verify that the AWDB is configured correctly.

a. Check the realm.log for the following line:

"ERROR

com.cisco.ccbu.finesse.realms.ccerealm. CCERealmConfig -
Cannot connect to any AWDB! Ensure that at least one AWDB
is configured properly and running!"

This line indicates that Finesse cannot connect to the AWDB.

b. Check that the values entered in the Contact Center Enterprise
Administration & Data Server Settings gadget are correct.

* Verify that the username entered is a Windows domain
user.

* Verify that the username is not prepended with the domain
(for example, domain\username).

* Verify that the port configured is open to the Finesse server.

C. Check that the AWDB is set up correctly and running.

* The AWDB SQL server must use Windows authentication.

* Verify that the AWDB server is up and that the Distributor
service is running.

Restart Cisco Finesse Tomcat on the primary and secondary Finesse
servers.

Verify that the agent's device is properly configured in Unified
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If Then

Communications Manager and is active.
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Cisco Finesse Virtualization

* Virtualization Hardware, on page 43

* Virtualization Software, on page 43

* Deploying Virtual Machines for Cisco Finesse, on page 43

* Changing the Boot Order of the Virtual Machine, on page 44

Virtualization Hardware

Before you install the Finesse software on any server, you must address the following requirement:

* If you are performing a fresh install of Finesse in any deployment, be sure to verify that the virtual
machine is also fresh (no previously-installed OS is present in the VM).

* If you use SATA 7200 RPM disks in your server, you must configure the datastore as RAID 10.

Virtualization Software

All Finesse servers run on VMs using the Unified Communications Operating System (Unified OS or UCOS).
See https://www.cisco.com/c/dam/en/us/td/docs/voice ip _comm/uc_system/virtualization/
virtualization-software-requirements.html.

* Finesse ISO or DVD

N

Note You must install Finesse by configuring a DataStore ISO file on the virtual CD
or DVD drive of the target VM.

» ESXi must be installed prior to the installation of Cisco Finesse.

Deploying Virtual Machines for Cisco Finesse

Perform the following steps in vSphere client to deploy the Virtual machines:
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Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7
Step 8
Step 9

Before you begin
See Unified Communications VM Ware Requirements.
The following software requirements apply specifically to Finesse:

* For other third-party software requirements and for a list of approved UCS servers, see the server
requirements and version compatibility with Unified CM sections in the Cisco Unified Contact Center
Enterprise Design Guide available at
http://www.cisco.com/en/US/products/sw/custcosw/ps 1844/products_implementation design guides_list.html.

Procedure

Highlight the host or cluster to which you wish the VM to be deployed.
Select File> Deploy OVF Template.

Click the Deploy from Fileradio button and specify the name and location of the file you downloaded in the
previous section OR click the Deploy from URL radio button and specify the complete URL in the field,
then click Next.

Enter the name of the VM machine that you are creating and the location where it will be created.
Choose the type of deployment (Production or Lab).

Choose the datastore on which you would like the VM to reside (ensure there is sufficient free space to
accommodate the new VM), then click Next.

Verify the deployment settings, then click Finish.
Update boot order as per instructions as specified in the topic Changing the Boot Order of the Virtual Machine.
Insert the Finesse disk and follow the instructions specified in the topic Cisco Finesse Server Installation.

Changing the Boot Order of the Virtual Machine

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

You must change the boot order of the Virtual Machine so that the system boots off the CD/DVD drive for
the install. Perform the following steps to change the boot order of the Virtual Machine:

Procedure

In VMware vSphere Client, power off the virtual machine onto which you deployed the OVA .

In the left pane of vSphere Client, right-click the name of the virtual machine, and select Edit Settings.
In the Virtual Machine Properties dialog box, select the Options tab.

In the Settings column, under Advanced, select Boot Options.

Under Force BIOS Setup, check The Next Timethe Virtual Machine Boots, Force Entry into the BIOS
Setup Screen check box.

Click OK to close the Virtual Machine Properties dialog box.
Power on the virtual machine (the virtual machine boots into the BIOS menu).

Navigate to the Boot menu and change the boot device order so the CD-ROM device is listed first and the
Hard Drive device is listed second.
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Step 9 Save the change and exit BIOS setup.

Note After finishing the installation, consider changing the boot order back so that the Hard Drive device
is again listed before the CD-ROM device.
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APPENDIX A

Network and System Services Used for Cisco
Finesse

To view the platform TCP/IP services, UDP services, and Unix domain sockets that are used by Cisco Finesse,
access the CLI using the Administrator User credentials and enter the following command:

show network all detail

To view the system services that are used by Cisco Finesse, access the CLI using the Administrator User
credentials and enter the following command:

utils servicelist

The following services are enabled by default when Cisco Finesse starts. These services are essential for
product operation and must not be disabled.

* A Cisco DB[STARTED]

* A Cisco DB Replicator[ STARTED]

* Cisco AMC Service[ STARTED]

* Cisco Audit Event Service[ STARTED]

* Cisco CDP[STARTED]

* Cisco CDP Agent[STARTED]

* Cisco Certificate Change Notification[STARTED]
* Cisco Certificate Expiry Monitor[ STARTED]

* Cisco DRF Local[STARTED]

* Cisco DRF Master[STARTED]

N

Note Cisco DRF Master should be started only on the Finesse primary (A Side) server.

Status on the Finesse primary (A Side) server should be “STARTED”. Status on
the Finesse secondary (B Side) server should be “STOPPED” Command Out of
Service.

* Cisco Database Layer Monitor[ STARTED]
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* Cisco Finesse Notification Service[ STARTED]

* Cisco Finesse Tomcat[ STARTED]

* Cisco Log Partition Monitoring Tool[STARTED]
* Cisco RIS Data Collector[ STARTED]

* Cisco RTMT Reporter Servlet[STARTED]

* Cisco Syslog Agent[STARTED]

* Cisco Tomcat[STARTED]

* Cisco Tomcat Stats Servlet{f STARTED]

* Cisco Trace Collection Service[ STARTED]

* Cisco Trace Collection Servlet[STARTED]

* Cisco Web Proxy Service[STARTED]

* Host Resources Agent[STARTED)]

* MIB2 Agent[STARTED]

* Platform Administrative Web Service[ STARTED]
* SNMP Master Agent[STARTED]

* SOAP -Log Collection APIs[STARTED]

* SOAP -Performance Monitoring APIs[STARTED]
* SOAP -Real-Time Service APIs[STARTED]

* System Application Agent{STARTED]
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